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Melio File System Installation and User’s Manual 

Copyright and Disclaimer 

The information in this documentation was prepared by Sanbolic, Inc. with reasonable care and is believed to be accurate. 

However, Sanbolic, Inc. shall not assume responsibility for losses or damages resulting from any omissions, inaccuracies, or 

errors contained herein. Sanbolic, Inc. may make improvements or changes in this documentation or in the product and 

programs described in this documentation, at any time and without notice and as it sees fit. This publication describes the state 

of this product at the time of its publication, and may not reflect the product at all times in the future. 

No part of this documentation may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, 

electronic, mechanical, by photocopying, recording, or otherwise, without the prior written permission of Sanbolic, Inc. 

SANBOLIC, INC. MAKES NO WARRANTY EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED 

TO ANY IMPLIED WARRANTIES OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, 

REGARDING THESE MATERIALS AND MAKES SUCH MATERIALS AVALIABLE SOLELY ON AN "AS-IS" BASIS. 

IN NO EVENT SHALL SANBOLIC, INC. BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, INCIDENTAL, OR 

CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF THESE 

MATERIALS.  

The End-User Software License Agreement, which is included with the software program and this manual, specifies the 

permitted and prohibited uses of the software program.  

Please read the terms and conditions of the Agreement before commencing use of the software program. 

© Copyright Sanbolic, Inc., 2003. All rights reserved. 

Printed in the USA 

 

Trademarks 

Sanbolic and Sanbolic logo are registered trademarks of Sanbolic, Inc.  

Melio FS and the Melio FS logo are registered trademarks of Sanbolic, Inc.   

Third-Party Trademarks: 

Microsoft Windows 2003 and Windows 2008 are trademarks of Microsoft Corporation. All other brand names, product names 

or registered belong to their respective holders. 
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End-user License Agreement 

 
 
IMPORTANT NOTICE TO END-USER. PLEASE READ THE TERMS AND CONDITIONS OF THIS AGREEMENT 

CAREFULLY. 

 

THIS SOFTWARE LICENSE AGREEMENT („AGREEMENT”) IS A LEGAL AGREEMENT BETWEEN END-USER 

AND SANBOLIC, INC. („SANBOLIC”) FOR USE OF THIS SOFTWARE, INCLUDING THE ASSOCIATED PRINTED, 

ONLINE, OR ELECTRONIC DOCUMENTATION, CD-ROM MEDIA, COPY-PROTECTION HARDWARE, AND ANY 

AND ALL COPIES OF AND MAINTENANCE RELEASES TO THE SOFTWARE, AS WELL AS ANY THIRD-PARTY 

SOFTWARE EITHER EMBEDDED IN OR OTHERWISE INCLUDED AS PART OF THE SOFTWARE („SOFTWARE”). 

BY INSTALLING, COPYING, OR USING THIS SOFTWARE, END-USER IS DEEMED TO HAVE ACCEPTED AND 

AGREED TO THE FOLLOWING: 

 

1. GRANT OF LICENSE AND LIMITATIONS. In consideration for payment of the applicable license fees, SANBOLIC 

grants to END-USER and END-USER accept a personal and non-exclusive license to use the Software in object-code format, 

including the associated documentation, subject to the terms, conditions, and restrictions of this Agreement. END-USER may 

install a copy of the Software on a single computer owned, leased, or otherwise controlled by END-USER solely for its 

internal purposes. If END-USER wishes to make concurrent use of the Software on two or more computers, END-USER must 

acquire a license for each separate machine. END-USER agrees not to modify, adapt, translate, decompile, disassemble, or 

otherwise reverse engineer any portion of the Software, except and only to the extent expressly permitted by applicable law. 

END-USER may not sell, loan, lease, sublicense, or distribute the Software, or otherwise create derivative works based upon 

the software. Prior to disposing of any media containing the Software, END-USER agrees to erase or otherwise destroy any 

Software stored on such media. This license does not grant END-USER any right to any enhancements or new versions of the 

Software. Any such enhancements or new versions, if available, may be obtained by END-USER at SANBOLIC’s then current 

standard pricing, terms and conditions. 

 

2. OWNERSHIP OF SOFTWARE. All title, rights, and interests in and to the Software and underlying intellectual property 

rights in the Software are and shall at all times remain the valuable property of SANBOLIC or its suppliers. END-USER 

acknowledges that the Software contains valuable trade secrets or confidential and proprietary information of SANBOLIC, and 

that use of the Software does not transfer any title to or rights of ownership in the Software to END-USER. END-USER shall 

not remove or alter SANBOLIC’s or its supplier’s copyright, trademark, or other proprietary notices and legends included in 

the Software. END-USER agrees to take reasonable steps to prevent any unauthorized access, disclosure, distribution, 

possession, alteration, transfer, reproduction, or use of the Software. SANBOLIC and its suppliers reserve all rights not 

expressly granted to END-USER under this Agreement. THE SOFTWARE IS PROTECTED BY INTELLECTUAL 

PROPERTY LAWS AND INTERNATIONAL TREATIES. THE SOFTWARE IS LICENSED TO END-USER AND IS NOT 

SOLD. 

 

3. BACKUP COPIES. END-USER may make one (1) copy of the Software for security backup and archival purposes. END-

USER shall place the same copyright and other proprietary notices and legends that appear on the validly licensed copy of the 

Software in any such backup copy. 

 

4. TRANSFERS. SANBOLIC shall have the right to assign its rights and obligations hereunder in whole or in part. END-

USER may permanently transfer all of its rights and obligations under this Agreement to a third-party transferee provided that 

(i) END-USER transfers a validly executed assignment and assumption of its rights and obligations with respect to the 

Software; (ii) END-USER does not retain any copies of the Software or prior versions or upgrades, enhancements, or updates 

to the Software; (iii) END-USER provides SANBOLIC with notice in writing of the transfer and the name, address and contact 

person for the transferee; and (iv) the third-party transferee accepts in writing the terms and conditions of this Agreement. 

Except as provided for above, END-USER may not transfer or assign this Agreement or any of its rights or obligations under 

this Agreement without the prior written consent of SANBOLIC, and any such unauthorized transfer shall be null and void. 

 

5. LIMITATION OF WARRANTIES.  Sanbolic warrants that the storage media on which the Software is furnished will be 

free from physical defects in materials and workmanship under normal use for a period of thirty (30) days from the date of 

delivery to END-USER, and that such storage media shall contain a complete copy of the Software.  Any other software and 

any hardware furnished with or accompanying the Software is not warranted by Sanbolic.  As the sole remedy for any breach 

of the foregoing warranties in this paragraph, Sanbolic will replace any and all such defective media with media free from 

defects and containing a complete copy of the Software. 

 

EXCEPT AS STATED ABOVE IN THIS SECTION, THE SOFTWARE IS (AND ANY SERVICES OR SUPPLEMENTS 

NOW OR HEREAFTER PROVIDED WITH RESPECT TO THE SOFTWARE ARE) PROVIDED "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
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IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR 

PURPOSE.  SANBOLIC AND ITS SUPPLIERS SPECIFICALLY DO NOT WARRANT THAT THE FUNCTIONS OR 

FEATURES OF THE SOFTWARE WILL MEET ALL OF THE END-USER’S REQUIREMENTS; WILL OPERATE IN 

ALL THE PRODUCT COMBINATIONS WHICH MAY BE SELECTED FOR USE BY THE END-USER; THAT THE 

OPERATION OF THE SOFTWARE WILL BE ERROR-FREE OR UNINTERRUPTED; OR THAT ERRORS OR 

DEFECTS IN THE SOFTWARE WILL BE CORRECTED.  THE ENTIRE RISK AS TO THE QUALITY AND 

PERFORMANCE OF THE SOFTWARE (OR ANY SERVICES OR SUPPLEMENTS NOW OR HEREAFTER PROVIDED 

WITH RESPECT TO THE SOFTWARE) IS WITH THE END-USER.  TO THE MAXIMUM EXTENT PERMITTED BY 

APPLICABLE LAW, END-USER EXPRESSLY WAIVES ALL WARRANTIES OR CONDITIONS NOT SPECIFICALLY 

SET FORTH HEREIN. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES 

AND CERTAIN OF THE ABOVE EXCLUSIONS MAY NOT APPLY TO END-USER. NO AGENT, DISTRIBUTOR, OR 

RESELLER IS AUTHORIZED TO MAKE ANY ADDITIONAL WARRANTIES OR MODIFY THE FOREGOING 

LIMITED WARRANTY. 

 

6. LIMITATION OF LIABILITY. IN NO EVENT SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE FOR ANY 

SPECIAL, PUNITIVE, INDIRECT, CONSEQUENTAL, OR ANY OTHER DAMAGES, INCLUDING, BUT NOT 

LIMITED TO, LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF USE, LOSS OF DATA, PROPERTY DAMAGE, OR 

ANY OTHER COMMERCIAL OR ECONOMIC LOSS OF ANY KIND ARISING OUT OF THIS AGREEMENT, OR THE 

USE OR PERFORMANCE OF THE SOFTWARE, OR THE RESULTS OBTAINED THROUGH USE OF THE 

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE, OR FOR ANY CLAIM BROUGHT 

AGAINST END-USER BY ANY OTHER PARTY, NOR SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE FOR ANY 

DAMAGES WHATSOEVER RESULTING FROM ANY ACT BEYOND ITS REASONABLE CONTROL. TO THE 

MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW. ANY LIABILITY OF SANBOLIC OR ITS SUPPLIERS 

FOR DAMAGES ARISING FROM EITHER THIS AGREEMENT, OR THE END-USER’S USE OR PERFORMANCE OF 

THE SOFTWARE, UNDER ANY LEGAL THEORY, WHETHER IN CONTRACT, TORT, NEGLIGENCE, STRICT 

LIABILITY OR OTHERWISE SHALL BE LIMITED EXCLUSIVELY TO REPLACEMENTOF THE SOFTWARE OR 

REIMBURSEMENT OF THE AMOUNT OF THE LICENSE FEES PAID BY END-USER FOR THE SOFTWARE, AT 

SANBOLIC’S SOLE OPTION. END-USER AGREES THAT THIS LIMITATION OF LIABILITY SHALL ALSO APPLY 

TO AND BENEFIT SANBOLIC’S SUPPLIERS, DISTRIBUTORS, OR RESELLERS. SOME JURISDICTIONS DO NOT 

ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL 

DAMAGES, AND THE ABOVE LIMITATION AND EXCLUSION OF LIABILITY MAY NOT APPLY TO END-USER. 

 

7. TERMINATION. Without prejudice to any of its legal rights and remedies, SANBOLIC may terminate this Agreement if 

END-USER fails to comply with the terms and conditions of this Agreement. In the event of any such termination, END-

USER shall discontinue all use of the Software, and return to SANBOLIC all copies of the Software in its possession. 

 

8. NOTICE TO U.S. GOVERNMENT USERS. If END-USER is a unit of the United States Government, the Software and 

associated documentation are provided with restricted rights. Use, duplication, or disclosure by the United States Government 

is subject to the restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software 

clause at DFARS 252.227-7013 or the restrictions set forth in (c)(1) and (2) of the Commercial Computer Software Restricted 

Rights at 48 CFR 52.227-19, as applicable, or in successor provisions, including the limitations set forth herein. Manufacturer 

is Sanbolic, Inc., 304 Pleasant Street, Watertown, Massachusetts, U.S.A. 

 

9. MISCELLANEOUS. SANBOLIC and END-USER further agree that (i) this Agreement shall be constructed in accordance 

with and governed by the laws of a Delaware Corporation applicable hereto, without regard to its conflict of law rules; (ii) the 

parties expressly exclude the application of the United Nations Convention on Contracts for the International Sale of Goods, 

and any local or international law, convention, or regulation which may provide an alternative law or construction, to the 

extent such waiver shall be permitted by applicable law; (iii) if any term of this Agreement is deemed void and unenforceable, 

the remainder of this Agreement shall remain valid and enforceable; (iv) in the event of conflict between the terms and 

conditions of this Agreement and END-USER’ s purchase order, quotation, or other equivalent, the terms of this Agreement 

shall be controlling. No conflicting term or condition contained in any purchase order, quotation or other equivalent, shall be 

binding upon SANBOLIC in any fashion without SANBOLIC’s written consent; (v) the parties consent to this Agreement 

being drawn up in the English language; and (vi) this Agreement may not be amended except in a writing executed by both 

parties. 

 

10. ENFORCEABILITY. END-USER acknowledges that this Agreement is binding and shall entitle SANBOLIC to enforce 

the above terms. END-USER further agrees that SANBOLIC suppliers referenced in the Software are intended beneficiaries to 

this Agreement, and, to the maximum extent permitted by applicable law, may enforce this Agreement as it relates to their 

intellectual property rights. 

 

11. EXPORT RESTRICTIONS. END-USER may not export or re-export the Software except in full compliance with 

applicable export controls laws and regulations, and unless a validated export license is obtained from the applicable regulatory 

agencies, as required. 
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12. ACKNOWLEDGEMENT. END-USER has read, understands, and agrees to be bound by the terms and conditions of this 

Agreement. IF END-USER IS NOT WILLING TO BE BOUND BY THE ABOVE TERMS, THE UNUSED SOFTWARE 

MAY BE RETURNED FOR REFUND OF THE LICENSE FEES PAID TO SANBOLIC OR THE DISTRIBUTOR OR 

RESELLER FROM WHICH END-USER ACQUIRED IT, PROVIDED THAT THE SOFTWARE IS RETURNED FOR 

REFUND WITHIN THIRTY (30) DAYS AFTER DELIVERY. PLEASE CONTACT THE VENDOR FROM WHICH YOU 

OBTAINED THE SOFTWARE FOR REFUND AND REFUND INSTRUCTIONS. 

 

 

Sanbolic, Inc., 2000. All Rights Reserved. 
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Installation and Setup of Melio FS 

Melio FS is a 64-bit symmetrical cluster file system that provides multiple servers with simultaneous read/write access to data 

stored on the same partition or Logical Unit Number (LUN) on SAN storage. 

 

Minimal System Requirements: 

• Pentium IV class processor or equivalent 

• 256 MB RAM 

• 11 MB free disk space 

• LAN (TCP/IP) connection 

• SVGA - min 800x600, 256 colors 

• Shared storage connected via Fiber Channel or iSCSI, but other interfaces are possible as well. 

 

Supported Operating Systems: 

• Windows Server 2003 x64 

• Windows Server 2003 R2 x64 

• Windows Server 2008 x86, x64 

• Windows Server 2008 R2 

 

Note: Support for Windows Server 2003 x86 and Windows Server 2003 R2 x86 is no longer available. 

 

Recommendations: 

• Melio FS employs a proprietary communications protocol (based on TCP and UDP) for file system management.    

To ensure that communications between Melio nodes are not affected by intermittent network issues, Sanbolic 

strongly recommends providing a dedicated network (i.e., VLAN or switch) for Melio cluster administration traffic. 

This network should be completely isolated from the rest of the LAN. 

 

Note: Melio FS does not support NIC teaming/bonding. Please ensure that the network interface assigned for Melio 

cluster administration traffic is not teamed with another network interface. 

 

• To simplify the management of and achieve greater performance from your shared storage, Sanbolic strongly 

recommends using Sanbolic LaScala cluster volume manager to manage Melio shared volumes. Designed for shared 

SAN storage, LaScala allows administrators to create basic partitions, volume sets and stripe sets and supports 

dynamic volume expansion. 

 

Installation Checklist: 

• Log on to the system in which Melio FS is going to be installed using an account with administrative privileges. 

• Make sure the Windows Management Instrumentation (WMI) service is running. 

• Confirm the system has TCP/UDP/IP connectivity to the LAN. 

• Install and connect your storage hardware using the instructions provided by the respective hardware manufacturers. 

Make sure the newly installed hardware is operating correctly. Check the event log for error messages and resolve all 

errors prior to installing Melio FS. 

• Use Sanbolic LaScala, Windows LDM or another volume manager to create a volume that will be formatted with 

Melio FS. While it is possible to have multiple Melio-formatted volumes at the same time, you cannot specify parts of 

a volume be used by Melio FS as the formatting process will erase all existing data on the entire volume. 

• If Melio FS is already installed, please refer to the “Upgrading Melio FS” guide located under Tech notes on the 

following page: http://www.sanbolic.com/support.htm. 
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Installation 

After double-clicking on the Melio 2010 setup file, a "Welcome" screen will be displayed: 

 

 
 
Accept the license agreement: 

 

 
 

Select an installation folder for Melio: 
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Select the software components you would like to install: 

 

Note: The option to install Melio FS is grayed out as it must be installed in order to use all other components. 

 

 
 

Select an IP address (network interface) for Melio cluster administration traffic: 

 

 
 

If you have Windows Firewall enabled and running, the installation automatically asks you to add TCP and UDP port 7777 in 

the port exceptions of the firewall: 
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If you later decide to change the IP/port pair (socket), Melio FS will automatically reconfigure Windows Firewall to 

accommodate for the new settings. If you are using a third party firewall, you’ll need to configure it manually or the servers 

will be unable to communicate with one other, which will lead to their inability to form a functional cluster. 

 

Select the user account that LaScala volume manager will use to manage Melio FS shared volumes: 

 

 
 

Select the user account that SILM will use to perform data mover operations: 

 

 
 

Click “Install” to install the selected components: 
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Select the user account that AppCluster will use to manage application clusters: 

 

 
 

Select the location to store the AppCluster configuration files: 

 

 
 

Select the resources you want managed by AppCluster: 

 

 



12 

 

 

Depending on the resources selected, the user will be prompted to configure the resources managed by AppCluster. 

 

For example: If SQL Server is selected, the following window will be displayed: 

 

 
 

Enter the names of the SQL Server instances you want AppCluster to manage. 

 

The installer will then ask the user to select the workload level for this server: 

 

 
 

Click “Install” to proceed with the installation of AppCluster: 
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The next step is to select “Trial” or “Full” mode: 

 

 
 

Running Melio FS in “Full” mode requires entering the serial number received when Melio FS was purchased. It is important 

to register all Melio instances using unique license keys (i.e., one license key per Melio node) to ensure they form a cluster. 

 

In “Trial” mode Melio FS has no functional limitations – all features are supported. However trial mode is time-limited and 

expires 14 days after a volume is formatted, at which time, the volume transitions to а read-only state. All data remains intact 

(i.e., nothing is destroyed), but you will not be able to store any new files on the volume. Once Melio FS is upgraded to “Full” 

mode, the write protection is removed and data can once again be written to the volume. 

 

After the setup is completed, the Melio FS kernel driver will start running. Installed components will include the "Melio FS 

Configuration" graphical user interface tool, several command line utilities and other internally used components. 

 

 
 
Click “Finish” to close the Setup program. 

 

Repeat the installation process on all machines that will share access to Melio volumes. 

 

Once Melio FS is installed on all machines, proceed to the next section to create your shared storage. 
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Formatting a volume with Melio FS 

To use Melio FS, format a new volume with Melio FS. Before doing so, ensure that the volume has a drive letter assigned and 

is displayed in Windows Explorer. Assigning a drive letter is achieved through Windows diskmgmt.msc management console. 

Make sure the volume has been assigned to all servers running Melio FS that will need to share access to it. 

 

To format a partition with Melio FS, right-click on the appropriate drive letter in Windows Explorer and select "Melio 

Format". Please note that formatting via the Windows context-sensitive (right-click) menu must be performed from one 

machine only, after which all servers running Melio FS will automatically discover and mount the shared volume. 

 

 
 

A confirmation message will be displayed: 

 

 
 
Click “Yes” to format the volume with Melio FS. 

 

Formatting a newly created volume with Melio FS usually takes several minutes to complete. If the volume is already 

formatted with Melio FS and there are other machines accessing the volume, the reformat operation will fail and an error 

message will be displayed. To format the volume, you need to ensure it is not in use by other servers and there are no open 

handles referencing it. 

 

Note: Formatting a volume that was previously formatted with a file system other than Melio FS is not recommended as it 

could lead to volume performance or stability issues. In the event that a previously formatted volume must be used, it is 

imperative that all other machines accessing the volume be disconnected from the storage or shut down. The reason is that 

NTFS is not SAN-aware and since other machines have no way of knowing that this particular NTFS volume has disappeared, 

Windows may still attempt to write data to the volume, which could lead to data corruption. Thus, it is strongly advised that 

only new, raw volumes be formatted with Melio FS. 

Specifics of operation with Windows 2003/2008 dynamic volumes 

The only way to create a new software RAID volume in Windows Server 2003/2008 is to utilize “dynamic disks” that are 

managed by Windows Logical Disk Management (LDM). Although Melio FS supports volume sets and all Windows software 

RAID levels, since LDM is not SAN-aware, which could lead to complications, Sanbolic recommends managing Melio FS 

shared volumes with Sanbolic’s LaScala cluster volume manager. Using LaScala, users can obtain the advanced functionality 

afforded by “dynamic disks” using basic disks. 
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If LDM is going to be used, it is important to follow the procedure described below when using dynamic volumes on multiple 

machines connected to shared storage: 

 

1. Turn off all servers except one. 

2. From this machine create the appropriate dynamic disks and storage volumes (RAID 0, 1, 5, volume sets). 

3. Now you can safely format them with Melio FS. 

4. Turn on a second machine and enter Disk Management. The dynamic disks will be displayed as foreign. 

When you import them, they will be automatically recognized by LDM and Melio FS.  

5. Turn on the other machines one by one and repeat the import via Disk Management. 

 

Please note that you must not launch Disk Management after the above steps are completed оr LDM will mark the dynamic 

disks as “offline,” disrupting normal Melio operations. You should only start Disk Management on the last machine connected 

to the shared storage. 

 

Using Sanbolic LaScala cluster volume manager in conjunction with Melio FS, dynamic disks are not required. Since both 

applications are designed for shared SAN storage, all functions, including more advanced functions such as dynamic volume 

expansion, can be performed using “basic disks.” This means there is no need to convert disks to “dynamic disks” to achieve 

advanced functionality when LaScala is used to manage shared volumes formatted with Melio FS. 

Usage 

Melio FS is a shared file system that supports all standard file system operations such as creating, copying, moving, renaming 

and deleting files and directories, reading from and writing to files, changing file and directory attributes, locking whole files 

or particular sections only, etc. Since Melio FS is a shared file system, all of the above operations can be safely performed on a 

volume by multiple machines simultaneously. 

 

There is no user interface at the core of Melio FS. Its functionality is accessed indirectly through Windows Explorer and all 

user applications using operating system commands such as "copy" or "dir" or via the standard Win32 programming functions 

such as CreateFile(). Melio FS is tightly integrated with Windows 2003/2008 server operating systems and supports all 

commands and system API functions transparently. Thus an application that works with NTFS will also work with Melio FS. 

 

Melio FS is a fully-journaled file system, which means that all metadata changes are recorded in a special area on the disk 

called a journal (aka a log). If a machine crashes for example, the file system may be left in a non-consistent state, potentially 

leading to data corruption. To prevent this, all interrupted operations are checked and replayed using the journal. This is 

performed upon first volume access by one of the available nodes in the cluster (not necessarily the crashed node). It is 

important to note that the process of replaying a journal can take some time and delays can be expected under these 

circumstances. 

Performing additional tuning 

There are additional parameters you can configure in the Melio FS Configuration graphical interface. 

 

Note: Default values are designed to work under the majority of configurations. As such, modifications made to any of the 

parameters described below should not be made without first conferring with Sanbolic Technical Support. 

Specifying TCP/IP communications settings 

During installation you will be asked for a TCP port and IP address used for communication between Melio instances on 

different machines. An IP address must be selected if a computer has more than one valid IP address. Otherwise you can leave 

the value at the "Default IP" setting. (See diagram on following page.) 

 

Note: Sanbolic strongly recommends the use of a standalone network in the form of a VLAN or hardware switch for Melio FS 

cluster administration traffic. Using a network that is separate from the rest of your LAN will minimize the potential for 

network issues such as congestion to adversely affect Melio communications, ensuring optimal performance at all times. 

 

Note: Melio FS does not support NIC teaming/bonding. Please ensure that the network interface assigned for Melio cluster 

administration traffic is not teamed with another network interface. 
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Fine Tuning Melio FS 

 
Disk Flush Disabled - Setting this option may help in situations where hardware issues exist. Certain disk storage does not 

support this command or support it effectively (usually when the command is issued it takes a lot of time to be completed by 

the underlying storage). When checked, Melio FS will not issue disk flush commands. If unsure, leave unchecked. 

 
Pre-allocation Disabled – Setting this option is not recommended unless advised by a Sanbolic support engineer. 

 

 

Modifying cluster-wide times 

These times affect the operation of all machines in the cluster. The parameters are volume-specific and once changed, are 

written to the respective volume and propagated throughout the entire cluster. 

 

Note: Cluster Times values are written directly on the volume, which requires that the volume be locked temporarily by one 

machine. This will make the respective volume inaccessible to all other machines in the cluster for a short time while the 

changes are written. Also, you must ensure there are no open files and/or handles for this volume on the other machines, as this 

will prevent the volume from being locked. If there are any open files and/or handles for the volume, the message "Failed to 

lock volume. Access is denied." will be displayed. 

 

Note all times are in milliseconds: 
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Max IO Time - This is the maximum time an operation to or from the shared disk can last. 

 

Heartbeat Period - This is the time interval at which the heartbeat check is invoked. 

 

Max Net Roundtrip - This is the maximum time in which a machine expects to receive an answer from the other computers in 

the cluster to its request over the TCP/IP network. 

 

Max OS Response Delay - The interval between the expected start of a system operation in the computer and its real start. 

Unless the computer is under constant 100% load, this value should not be changed. 

 

Min Crash Recovery Delay - This is the minimum time it takes for the cluster to determine that a machine is not responding 

and evict it from the cluster. While this process takes place, I/O operations may be disrupted, depending on the file system’s 

read/write pattern. This is because machines must refrain from changing data on the disk in order to ensure its integrity. This 

delay depends on all the preceding parameters. It cannot be directly changed and is calculated based on the other values. 

 

Clicking on the "Reload" button rereads the volume values. After applying the changes to a volume, press the Reload button to 

make sure you see the most recent numbers. 

Viewing/modifying registration details 

Using the registration window (see screen below) you can upgrade Melio FS from “Trial” to “Full” mode, apply new Melio 

license or check supported features. 

 

 
 
Transitioning from “Trial” to “Full” mode takes place on the fly. Simply enter the user name, company name and serial 

number and click “Apply.” Please note that it is not possible to form a cluster that includes nodes using different license types. 

If you have a cluster of licensed Melio nodes, a machine running in “Trial” mode will not be able to join the cluster (and vice 

versa). In such situations, an appropriate message is written in the System event log. 

Per Process Tweaks 

There are a number of settings that affect the way a process behaves. 
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Report fs as NTFS – Specifying a value other than zero enables this setting, which some applications may require in order to 

work properly with Melio FS. 

  

Disable Access Time Update - Specifying a value other than zero enables this setting, which suppresses the "Date accessed" 

property of files. With this parameter enabled, a significant increase in performance may be observed when working with files 

and/or directories, i.e., viewing directory contents, reading files, opening multiple files, etc. 

 

Disable Cache Back - Specifying a value other than zero enables this setting, which may result in increased performance for 

some applications. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

Block application access - Specifying a value other than zero enables this setting, preventing the specified application from 

accessing the file system. 

 

Ignore Write Through - Specifying a value other than zero enables this setting, causing the file system to ignore the 

FILE_FLAG_WRITE_THROUGH.  

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

Ignore No Buffering - Specifying a value other than zero enables this setting, causing the file system to ignore the 

FILE_FLAG_NO_BUFFERING. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

Enforce Write Through - Specifying a value other than zero enables this setting, which enforces the 

FILE_FLAG_WRITE_THROUGH. This setting may fix fluctuations in the performance of certain applications, i.e., video 

applications. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

Enforce No Buffering - Specifying a value other than zero enables this setting, which enforces the 

FILE_FLAG_NO_BUFFERING. This setting may fix fluctuations in the performance of certain applications, i.e., video 

applications. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

Dirty Page Threshold – Specifying an integer value informs the system of the threshold for dirty pages within the system’s 

cache before they are flushed. For example, if there are multiple files opened by the specified process, this setting will affect 

the dirty pages of each file. The default value is 0, indicating that there is no threshold. This setting is on a per file basis. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling this parameter on 

your own accord may present undue risk. 

 

The settings that correspond to the [Default] process are global settings* - they affect all processes. If a process is added, its 

settings will override the global ones. 

 

You can add a process by right-clicking in the Process pane. This will allow you to browse for the executable file. To add the 

preferred settings, you must select the desired process first and then right-click in the "Tweaks for process" window pane. You 

will notice that the relevant process is displayed after "Tweaks for process". 

Note: It is not recommended to change global settings, since this may lead to unexpected behavior of the file system. Instead, 

changes should be made on a per process basis. 

Per Volume tweaks 

These tweaks manage the behavior on a per volume basis. These can be set globally for all Melio volumes by using them on 

the [Default] placeholder or individually for each volume available. There are two per volume tweaks. 

 

• The first one commands the Quality of Service /QoS/. To use the QoS tweak first select the appropriate volume, then 

right click in the "Tweak Name" column and choose "Add Enable QoS". This will add a value of 1 (enabled) to the 

tweak. A default Melio installation doesn’t have QoS enabled. 

• The second tweak commands the Level 1 batch oplocks. If you enable this tweak by specifying a value other than 

zero, Level 1 batch oplocks will be disabled per the volume specified or as a default. 
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Quality of Service 

To use this feature, please enable it as described in “Per Volume Tweaks.” QoS allows a user to assign a specific amount of the 

total throughput available in a storage controller to one or more processes running on a machine and/or one or more VHDs. 

Priorities are managed by a point system starting with the lowest priority (1) and ending with the highest priority (1000). 

 

 
 

You can add a process by right-clicking in the Process window pane, which will allow you to browse for the executable file. 

To add the preferred settings right-click, select a process and edit the “Points” column by entering the desired value. 

 

The following is an example illustrating the use of QoS:  

 

There are two processes – A and B, both of which are bandwidth intensive, and two other processes – C and D, which do not 

require as much bandwidth. Here is a scheme of the processes points: 

 

A – 10 points 

B – 10 points 

[Default] – 5 points 

C – 1 point 

D – 1 point 

 

Based on the above described point scheme, with Process A and Process C running at the same time, IO bandwidth will be 

redistributed between them as follows: Process A will have 9/10 (90%) of the bandwidth reserved, while Process C will have 

only 1/10 (10%) of the bandwidth. 

 

QoS by Filename works in conjunction with the per process scheme described above. Points assigned to a file/file group/folder 

are added to the ones for the process and then bandwidth reservations are calculated as above. If wildcards are used to 

generalize particular types of files, the process accessing them will get points added for all of them as a whole. Of course QoS 

can be set on a file by file basis by assigning weights to individual files, not groups. 

 

It is important to note that every process participating in QoS computation has points assigned - either explicitly set or using 

the default. 
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Supported features in the registered version 

You can obtain a registered version of Melio FS with partial or all features enabled. Melio FS offers the following features: 

 

Number of machines allowed simultaneous access to a volume – You may buy licenses which allow up to 5 machines to 

have simultaneous access to a volume or you may choose to have unlimited number of machines.  

 

Modify security – With this feature enabled, you will be able to modify the files and directories security.  

 

Extend volumes – This feature allows you to extend volumes formatted with Melio FS. Note that the volume manager 

application that you are using must support volume extension. 

 

Reparse points – Enabling this feature will allow a user to make use of the reparse points’ functionality.  

 

Sparse files – These are files that are mostly empty, enabling this feature allows you to use software that requires sparse files. 

 
Modify cluster affinity – Cluster Affinity allows a specific cluster node (or group of cluster nodes) to keep the connection to a 

shared volume after it has lost communications with the remaining cluster nodes.  

 

QoS – This is Melio FS quality of service feature that shares bandwidth between applications accessing the same volume, QoS 

can be set on both process and file/class of files basis. 

 
Extended file attributes –a file system feature that allows users to associate computer files with 

metadata not interpreted by the file system. This feature enables NTFS compatible extended file attributes on Melio FS. 

 

Open file by ID – File ID is a 64bit reference number for a file. This number is assigned by and specific to a particular file 

system. An application can use a file_id to open the corresponding file. 

 

Windows folder and file sharing – This feature allows sharing Melio FS files and directories on the network. 

 

Volume shadow copy (Snapshot) – The snapshot capability allows fully-journaled snapshots to be created from any server in 

the cluster. The snapshot capability supports standard APIs and can be invoked by industry standard VSS backup software. 

   

Command line utilities: 
 
set_cluster_affinity.exe* – This utility is located in the Melio FS installation folder (C:\ Program Files\Sanbolic\Melio FS\ by 

default) and is used for cluster affinity feature administration. Weights can be assigned on the same Melio volume from 

different servers. By default all volumes on all nodes have a cluster weight of 1, making them equal. The syntax is as follows: 

 

set_cluster_affinity.exe \\.\x: <weight>  or   

set_cluster_affinity.exe \\?\Volume{dab8cf5f-eede-11d9-935e-0011d89ce0a0} <weight> 

 

In case of TCP/IP network connection loss between some of the nodes, the cluster can split into several isolated smaller 

clusters attempting to access the shared volume. Normally this can lead to a split-brain situation in which different cluster 

groups think they own the same volume exclusively, which can result in data corruption. To prevent this situation from 

occurring, fencing mechanisms are used to dismount the volume on misbehaving nodes. When cluster affinity is set, weights 

are summed up and the heaviest cluster (highest total weight value) becomes the current owner of the volume, with all 

remaining nodes removed.  For example, if you set weight for a particular volume greater than the number of cluster members 

on one of the machines and then deliberately disrupt the network connection between them (i.e.,  changing the Melio 

TCP/UDP port number), all but the heaviest one will leave the cluster. 

 

Note: Cluster affinity is available with Melio Enterprise and Melio Datacenter editions only and will return an "Incorrect 

function" error message with Melio Professional and Melio Virtualization editions. 

 

vss_client.exe* – This utility is located in the Melio FS installation folder (C:\ Program Files\Sanbolic\Melio FS\  by default)  

and allows the manipulation of the cluster wide Melio VSS compatible snapshots. Below is a list of supported commands: 

 

Create Shadow       - create a new volume shadow copy 

Delete Shadows      - delete volume shadow copies 

Delete ShadowSet  - delete an empty shadow set 

List Shadows          - list existing volume shadow copies 

List Providers         - list registered volume shadow copy providers 

List Volumes          - list volumes eligible for shadow copies 
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Expose Shadow      - expose the shadow copy as a regular mount point or a network share 

Unexpose Shadow - remove an exposed shadow copy 

 

The syntax is very similar to the default vssadmin Volume Shadow Copy Service administrative command-line tool included 

in all Windows operating systems supporting VSS. For example, to create a volume shadow copy of a Melio FS volume: 

 

C:\Program Files\Sanbolic\Melio FS>vss_client.exe create shadow /for=X: 

 

Melio FS Volume Snapshots management tool. 

 

Successfully created shadow copy for 'X:' 

Shadow Copy ID: {ae24550c-446e-4f60-b8e8-634d1ff3c56b} 

Shadow Copy Volume Name: \\?\GLOBALROOT\Device\Volume{ae24550c-446e-4f60-b8e8-634d1ff3c56b} 

 

Then the shadow copy can be deleted, exposed as a network share, etc.  

 

Note: There is also a GUI application that can manage volume shadow copies provided with the default Melio FS installation. 

 
Sanbolic VSS GUI tool: 
 
Melio FS includes an easy-to-use graphical utility that makes working with Melio VSS Snapshots simple. It includes the ability 

to create/delete snapshots and mount/dismount (expose) them as a network share, thereby allowing the read only point in time 

copy of the whole volume to be accessed via the standard Windows file and folder sharing feature. 

 

 
 

Each action has a corresponding event in the “Messages” section in the bottom-right window pane of the interface, showing 

the operation status returned – success or a particular error message code. 

Troubleshooting 

This section includes several steps that can be performed if issues arise when using Melio FS shared storage. 

 

• First, make sure that your storage hardware is working properly. Check the system and application event log for error 

messages. If there are timeouts, controller or device errors, or something else, fix them according to your storage 

manufacturer’s guidelines. 

 

• Confirm that all machines participating in a cluster are running in the same mode (trial or full). If the machines are 

running in full mode, ensure that each machine is using a unique license key for the same edition of Melio FS – 

Virtualization, Professional, Enterprise or Datacenter. Mixing different editions in the same cluster is not supported. 

To check which mode and edition of Melio FS is running, go to Start > Melio Configuration > Help > About. 
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• Ensure there is network connectivity between all the Melio nodes in the cluster. This is especially important on multi-

homed systems (systems with several IP addresses). Make sure Melio uses the correct IP addresses on the machines, 

so Melio instances can communicate across the network. Also ensure that all Melio nodes are set to the same port 

number (this applies to both TCP and UDP). 

 

• Check the Event log for messages generated by Melio FS. The file system reports information, warning and error 

messages in the System log that can offer ideas regarding how to proceed with troubleshooting (i.e., pointing to a 

connectivity issue, disk array problem etc.). 

 

• Check the version of Melio FS being using by checking the information shown via Help->About in the Melio FS 

Configuration tool. This will help you determine if you need to download an update for Melio FS. 

 

• If you experience any anomalies, you can compare Melio FS with NTFS by running the same operations on an NTFS 

volume. If both file systems behave the same, then this is the intended behavior and is not indicative of a problem. 

How to request technical support 

The email address to contact technical support is support@sanbolic.com . When you submit a support request, please follow 

these guidelines: 

 

1. Supply information on your hardware and software. 

2. Supply the exact Melio FS version. 

3. Describe the steps to reproduce the problem. 

4. Supply event logs from all cluster nodes. 

5. Supply the exact error message. 

6. Specify how many times the problem occurred. 

7. State the actual results. 

8. Outline the expected results. 

1. Supply information on your hardware and software 

Use the All programs-> Accessories-> System tools -> System information or other product that will give details about the 

software and hardware being run on the system. 

 

Please describe the configuration of your central storage. Specify the type and speed of the connection to the hosts, the type of 

the disk array - JBOD or RAID, the model of the hard disks. Also describe the RAID controller, the RAID level, type of RAID 

(hardware/software), what software achieves the RAID functionality (Windows or third-party). Describe the topology of your 

storage network (how many hosts, how many disk arrays, how many loops, etc.). 

2. Supply Melio FS version 

The version of Melio FS can be obtained by using the Melio configuration tool. Launch the tool, select from the menu Help-

>About and write down the driver information at the bottom of the message box. 

 

Please make sure that you run the same version of Melio FS on all your machines. If for some reason this is not the case, please 

state the version of Melio FS on each of the machines. 

3. Describe the steps to reproduce the problem 

Please write down the exact steps that had lead to the particular problem. If we can't reproduce a problem, we will hardly be 

able to identify, investigate and fix it. 

 

Due to the distributed nature of Melio FS you will have to include some additional information as well. Take notes of the order 

in which machines were started - this directly corresponds to the order they enter the cluster and also affects some other aspects 

of Melio operation. 

4. Supply event logs 

Please send system and application event logs from all your systems forming a cluster. Melio FS writes its information in the 

System event log, but other software (e.g. MS SQL) enters important information in the Application event log. The event logs 

should be in native binary format (not as text files). To do so, perform the following steps: 
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• Launch Event viewer (Start menu -> Run... -> type "eventvwr" without the quotes) 

• Select System Log, from the ‘Action’ menu select ‘Save Log File as…’ Make sure the type of the file is “Event Log 

(*.evt(x))”. 

• Choose "Event Log (*.evt(x))" type of the log while saving.  

 

To further help Sanbolic support get as much information as possible out of log files, it is helpful to state the approximate time 

the issue occurred. 

5. Supply the exact error message 

If an error message is displayed in a message box, write down the exact text of the message. Please translate the text into 

English, if the message is in some other language. Also you may perform a screen capture of the error message as follows:  

 

1. Make sure that the error message is the active window. Press Alt+PrtScn to place a bitmap copy of the window in the 

Clipboard.  

2. Open the built-in MS Paint bitmap editor, and paste the image.  

3. Then go to "File->Save as" and choose a filename. 

 

In case a STOP error occurs that leads to a "blue screen of death", it is important to obtain the kernel memory dump that should 

be created at %SystemDrive%:\Windows\Memory.dmp. If you have made some analysis or suspect it may be Melio FS 

related, please compress and upload it via the file manager in your account at http://clients.sanbolic.com. Then contact 

support@sanbolic.com with a problem description according to the steps in this section, we’ll analyze the dump and advise 

according to our findings. 

6. Specify how many times the problem occurred 

The best property a problem may have is to be reproducible every time a particular test is run. Unfortunately this is not always 

the case, if a something shows up only once chances are it won't be discovered. 

 

Please specify the frequency with which a particular bug is occurring - every time you use the same steps, intermittent (how 

many times in how many tests), just once. 

7. State the actual results 

Describe the exact results achieved during the test using quantitative values, when possible. For example, avoid saying just 

"the machine hangs". Instead say something along the lines of "Windows Explorer stopped responding (hanged), we waited for 

X minutes, nothing changed, we had to kill the explorer process". 

8. Outline the expected results 

Please describe in detail the expected test results. 

 

 

 

 

 

 

 

Contacting Sanbolic 

Sanbolic Inc. 

Support contact: support@sanbolic.com 

Information requests: info@sanbolic.com 

Sales inquiries: sales@sanbolic.com 

Web site: www.sanbolic.com 

 

Mailing address: 

Sanbolic, Inc. 

304 Pleasant Street 

Watertown, MA 02472 

USA 


